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Chapter

1

Getting Started

Introduction

Synchrony( is analytic software designed for business analysts and decision-makers to examine in-depth relationships across multiple aspects of their businesses.  Based on the foundation of relational OLAP, and extended to encompass the full capability of multidimensional analysis, Synchrony permits you to understand your true business drivers.  By utilizing temporal concepts and methodology, Synchrony becomes the framework for a new class of analytic application.
The goal of this documentation is to familiarize you with the ways you can use Synchrony to answer your important business questions so that you can begin using it productively right away.  Utilizing sample databases, you will take control of business scenarios for a grocery store, credit card transactions, and a frequent flyer program.  By doing so, you will learn how to maximize the power of Synchrony from your own desktop, and be able to apply what you learn in these scenarios to answer your own business questions. 

About Synchrony Demo

There are three data marts available on Synchrony Demo. Each of these data marts has five reports associated with it. You may open any of these reports and run them against the databases provided with the software. Chapters 2, 3, and 4 in this document describe in a step by step manner how each of these reports were constructed. We suggest that you choose the data mart that most interests you and step through the construction of at least a few of the reports included. You may also want to try constructing reports of your own design.

The data marts included with Synchrony Demo are:

Credit Card Transactions Data Mart 

This is a marketing/customer profitability sample database from the credit card industry that includes credit cardholder account number, address, demographic, and purchase transaction information.  Data is available for Q4 1994 and Q4 1995.

Grocery Data Mart 

This is a sample database from the retail industry that includes product, sales, promotion, and store information.  Data is available for the full years 1994 and 1995.

Frequent Flyer Data Mart

This is a revenue generation/loyalty program sample database from the airline industry that includes customer, flight, fare, and sales channel information.  Data is available for Q4 1994 and Q4 1995.

Synchrony Demo allows you to run reports scripted in this document and any reports you construct on your own.  All reports constructed must use one of the sample data marts included.  Synchrony Demo does not support the ability to query your own data marts.  To try your own data, please contact if… to find out about the Synchrony Evaluation Program.

Synchrony Demo runs with Microsoft Access databases that are included with the Synchrony Demo CD.  The full version of Synchrony supports a number of RDBMSs as listed in the Synchrony Data Sheet.

Synchrony Demo supports “one-button” access to Microsoft Excel from the Synchrony application.  Unlike the full version of Synchrony, Synchrony Demo does not support the ability to call Synchrony directly from Excel.

The titles for the Synchrony Demo reports include the names of the sample data marts.  For example, Credit Card Transactions – Simple Query means that the Credit Card Transactions data mart is used.  You must select Credit Transactions when creating a new report.  See the section Creating Your First Report.
To Install Synchrony Demo

· Please insert the Synchrony Demo CD and follow the installation instructions on screen.  If the CD does not autorun, go to Add/Remove Programs in the Control Panel, and click the Install button.  Follow the instructions on your screen.

· Note that in addition to installing the Synchrony Demo software, the Synchrony User Manual will also be installed in both HTML and Microsoft Word 7.0 formats. You may refer to those documents to supplement the information contained within this document.

Getting Started

· By default, the installation program has already configured Synchrony Demo to run the sample data that we are going to be using in order to familiarize you with the product.

· Upon launching the program, you are presented with two choices: New Report and Open Report.  These options are also available from the File menu.
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· To create a new report, click on New Report and select the data mart for which you wish to create a report.

· To open an existing report, click on Open Report, expand the report list for one of the provided data marts, and choose one the existing reports.

· The main Synchrony window will appear. The main Synchrony window is divided into two parts; the Report Pane, which takes up the lower half of the screen and resembles a spreadsheet, and the Family Pane, which takes up the upper half of the screen.
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The central table shown in the Family pane is called the Fact table.  The tables arranged around the Fact table are referred to as Dimension tables.  In every Family Pane, there is always a Fact table, and anywhere from 1 to 20 Dimension tables.  In the illustration above, the Family pane is displayed in Star View mode.  If there are too many dimensions to effectively display the information in Star View mode, Synchrony will automatically switch to Single View mode.  In Single View mode, you will see a list that includes the titles of the available dimension tables.  By clicking on the dimension table you wish to view, you will see the details of your chosen dimension table displayed.

The Fact table contains the facts, or measures, relating to your business.  Anything from the Fact table can be dragged down onto the report pane.  To do so, point at the item in the Fact table you wish to drag onto the report pane, hold down the left mouse button, and drag the icon onto the report pane.

A dimension table contains lists of Fields, Groups, and Studies. Fields represent the attributes associated with the dimension. Groups and Studies represent constraints constructed for a dimension.  You can select between these three by clicking on the Fields, Groups, or Studies tab on a given dimension.
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The three have somewhat different characteristics in the way in which they are applied to a report in Synchrony.

First, only Fields can actually be dragged from the given dimension table directly onto the report pane, as can anything from the Fact table.  To do so, point at the item in the Dimension table you wish to drag onto the report pane, hold down the left mouse button, and drag the icon onto the report pane.

Groups and Studies, on the other hand, are constraints that may be applied either to the report as a whole, or to individual fact columns in the report.  To apply a Group or Study constraint, simply drag and drop it onto a fact column or onto the report title area.  In other words, Groups and Studies cannot be used to create columns in the report pane, only to constrain existing fact columns there.

Toolbar and Menus

Before we delve deeply into Synchrony, let’s go over some basic toolbar and menu functionality.
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· The purpose of the Clear function on the Report menu is to clear the results obtained from running the report.  The column headers remain intact.

· On the Help menu, Synchrony Help brings up the standard help dialog including an index, as does the question mark icon on the toolbar.  Books Online brings up the Synchrony User Guide, while if... on the Web consists of relevant links to the if... website.

· Single, Star and Report on the View menu and on the toolbar change how the main window is displayed.

· Selecting Run from the Report menu runs the report.  Selecting Refresh re-executes all of the queries which are associated with the report.

· Stop interrupts the running of a report.

Creating Your First Report

To create a new report:

1. Click on the Create New Report [image: image12.png]


 button or click on New Report from the splash screen if you have just launched the program.  Alternately, select File(New…
2. This will pop up the New Report dialog.

3. From this dialog, scroll down and choose one of the three available data marts, then click OK.
Chapters 2, 3, and 4 in this document walk you through the process of constructing a new report. You should select one of the available data marts and try following the steps described in constructing a report as detailed in one of those chapters.

Chapter

2

Credit Card Data Mart

Simple query

Lily is in the Credit Risk Department of a major credit card company.  She wants to understand how much credit risk each state had outstanding during November 1995.  November is traditionally a high spending month because of the holiday season.  

This is a simple query that shows a snapshot of data in time.  Most query tools can run simple queries such as this one.

To create a new report

· Go to File(New on the menu.

· Click on Credit Transactions.

· Click OK.

· If a dialogue box comes up asking if you want to save the report click No.

· Click View(Single on the menu.
1. To select fields for your report:

· From the Day dimension, drag and drop Date onto the report pane.

· From the Account dimension, drag and drop Account State onto the report pane.

· From Card Transactions (Fact table), drag and drop Current Debt onto the report pane.

· From the Day dimension, click the Groups tab and drag and drop Month = Nov 1995 onto the report title area.

2. To create report title:

· Right click on the report title area.

· Click in the Report Title edit box and type Credit Card Transactions – Simple Query.

· Click Close.

3. To create a subtotal:

· Right click on column A (Date) and select Properties(Break by.

· Check the Break on this column box to enable it.

· Click OK.

4. To run the report:

· Click Run Report [image: image13.png]
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5. To view full report:

· Choose View(Report from the menu.
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This is an example of a simple query that shows a snapshot of data in time.  Most query tools can run simple queries such as this one.

Complex Query

Evan is in the Marketing Department of a major credit card company.  He believes that customers holding high interest credit cards are high-risk spenders.  Evan wants to look at the spending patterns and the debt load of his high interest card customers over the heavy purchasing period of November and December 1995 and compare the differences in purchasing behavior and average current debt for each customer. 

This is a complex query where a constraint is created to look at only customers in the High Interest Card Product Category and only in the months of November and December 1995.  Then a comparison is made between the two months and a percentage difference is calculated.  Synchrony is able to show atomic data and identify individual customer account information within the High Interest Card Product constraint.  Some query tools are able to run queries with constraints and comparisons.  However, few are able to report atomic data (e.g. individual customer accounts, names, addresses) with constraints and comparisons applied.

To create a new report

· Go to File(New on the menu.

· Click on Credit Transactions.

· Click OK.

· If a dialogue box comes up asking if you want to save the report click No.

· Choose View(Single on the menu.
1. To create report:

· From the Account dimension, drag and drop Account No onto column A.

· From Card Transactions (Fact table), drag and drop Available Credit onto column B.

· From Card Transactions, drag and drop Number of Transactions three times onto columns C, D and E.

· From Card Transactions, drag and drop Current Debt three times onto columns F, G and H.

2. To constrain report and create report title:

· In the Card Product dimension click the Groups tab and drag and drop High Risk onto the report title area.

· Right click on the report title area.

· Click in the Report Title edit box and type Credit Card Transactions – Complex Query.

· Click Close.

3. To calculate an average of available credit:

· Right click on column B (Available Credit) and select Properties(Aggregate.

· Select Average.

· Click OK.

4. To select dates to constrain report columns:

· From the Day dimension, click the Groups tab and drag and drop the following:

a. Month = Nov 1995 to column C (Number of Transactions)

b. Month = Dec 1995 to column D (Number of Transactions)

c. Month = Nov 1995 to column E (Number of Transactions)

d. Month = Nov 1995 to column F (Current Debt)

e. Month = Dec 1995 to column G (Current Debt)

f. Month = Nov 1995 to column H (Current Debt)

5. To create comparisons:

· Right click on column E (Number of Transactions Nov 1995) and select Properties(Comparison.

· Select Percent Difference of.

· Click OK.

· Right click on column H (Current Debt Nov 1995) and select Properties(Comparison.

· Select Percent Difference of.

· Click OK.

· While holding down the Shift key, drag and drop Month = Dec 1995 from the Groups tab on the Day dimension onto column E (Percent Difference of Number of Transactions). Using the shift key sets the date as the one being compared.

· While holding down the Shift key, drag and drop Month = Dec 1995 from the Day dimension Groups tab to column H (Percent Difference of Current Debt) Using the shift key sets the date as the one being compared.

6. To create averages:

· Right click on column F (Current Debt Nov 1995) and select Properties(Aggregate.

· Select Average.

· Click OK. 

· Right click on column G (Current Debt Dec 1995) and select Properties(Aggregate.

· Select Average. 

· Click OK.

· Right click on column H (Current Debt Nov 1995) and select Properties(Aggregate.

· Select Average.

· Click OK.

7. To remove blank rows:

· Right click on column C and select Properties(Exceptions.

· Check the Omit Nulls box.

· Click OK.
8. To run the report:

· Click Run Report  [image: image15.png]



9. To switch to report view:

· Choose View(Report from the menu.
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This is a complex query where a constraint is created and a comparison is made between two periods of time. Some query tools are able to run queries with constraints and comparisons. However, few are able to report atomic data (e.g. individual customer accounts, names, addresses) with constraints and comparisons applied.

Complex query with a Study and slowly changing dimensions

Paige is in the Marketing Department of a major credit card company.  She wants to increase interest revenue for the company by increasing the average current debt of customers.  She knows that household income is a business driver of purchasing behavior.  She wants to look at the change in average current debt and total number of transactions for the months of November and December 1994 for customers that were granted a credit limit increase of $1000 or more in November 1994.  She wants to list the report by household income, account number, sum of total transactions, average available credit, average current debt for October and November 1994, percentage difference between the two months, sum of transactions for October and November 1994, and percentage difference between the two months.

This is a very complex query where a Study is created to save the results of a constraint of customers that were granted credit limit increases of $1000 or more in November 1994. Synchrony has the unique ability to create Studies. The results of applying constraints on various dimensions in a report can be saved as a Study. 

Slowly changing dimensions contain data that tend to change gradually over time.  Customer and product information are the most common data that varies over time.  If the speed of your industry is outpacing your data, then chances are you have data that varies over time and you need analytic software that can track slowly changing dimensions.  In this example, slowly changing dimensions are demonstrated by identifying the change in average current debt and total number of transactions between the periods October and November 1994.  Do you have analytic software that can tell you what changed over time?

To create a new report

· Go to File(New on the menu.

· Click on Credit Transactions.

· Click OK.

· If a dialogue box comes up asking if you want to save the report click No.

· Choose View(Single on the menu. 
1. To select fields for your report:

· From the Household dimension, drag and drop Household Income onto column A.
· From the Account dimension, drag and drop Account No onto column B.
· From Card Transactions (Fact table), drag and drop Amount onto column C.
· From Card Transactions, drag and drop Available Credit onto column D.

· From Card Transactions, drag and drop Current Debt three times onto columns E, F and G.

· From Card Transactions, drag and drop Number of Transactions three times onto columns H, I and J.

2. To create report title:

· Right click on the report title area.

· Click in the Report Title edit box and type Credit Card Transactions – Query with SCD.

· Click Close.

3. To create a Study:

· This study has been created for you.  If you wish to create it yourself, follow these steps.  Otherwise, skip to step 4.

a. With the Account dimension selected, click the Browse [image: image17.png]


 button. 

b. Select Tools(Study Changes from the menu

c. Select the Credit Limit field to study

d. For Type, choose Value Increase.

e. In the box marked Min enter 1000.

f. Select Month = Nov 1994 for the time constraint for the study.

g. Click OK.

h. Name the study Credit Limit Increase $1k+ in 11/94.

i. Click OK.

j. Close the Browser window.

4. To use the Study:

· From the Account dimension, click the Studies tab and drag and drop the study named Credit Limit Increase $1k+ in 11/94 to the report title.
· When prompted to choose a time period for the study, select All of time and click OK.
5. To select dates to constrain report columns:

· From the Day dimension, click the Groups tab and drag down the following:

a. Month = Nov 1994 to column C (Amount)

b. Month = Oct 1994 to column E (Current Debt)

c. Month = Nov 1994 to column F (Current Debt)

d. Month = Oct 1994 to column G (Current Debt)

e. Month = Oct 1994 to column H (Number of Transactions)

f. Month = Nov 1994 to column I (Number of Transactions)

g. Month = Oct 1994 to column J (Number of Transactions)

6. To create an average:

· Right click on column D (Available Credit) and select Properties(Aggregate.

· Select Average.

· Click OK. 

· Right click on column E (Current Debt Oct 1994) and select Properties(Aggregate.

· Select Average.

· Click OK.

· Right click on column F (Current Debt Nov 1994) and select Properties(Aggregate.

· Select Average.

· Click OK.

· Right click on column G (Current Debt Oct 1994) and select Properties(Aggregate.

· Select Average.

· Click OK.

7. To create comparisons:

· Right click on column G (Current Debt) and select Properties(Comparison.

· Select Percent Difference of.

· Click OK.

· Right click on column J (Number of Transactions Oct 1994) and select Properties(Comparison.

· Select Percent Difference of.

· Click OK.

· While holding down the Shift key, drag and drop Month = Nov 1994 from the Groups tab on the Day dimension onto column G (Percent Difference of Current Debt).  Using the shift key sets the date as the one being compared.

· While holding down the Shift key, drag and drop Month = Nov 1994 from the Groups tab on the Day dimension onto column J (Percent Difference of Number of Transactions).  Using the shift key sets the date as the one being compared.

8. To create an exception:

· Right click on column C (Amount) and select Properties(Exceptions.

· For Top Condition click on At or Above Value of  M.

· Enter 500 in the M = edit box.

· For Report Display, click Restrict to Exceptions.

· Click OK.

9. To run the report:

· Click Run Report  [image: image18.png]



10. To view full report:

· Choose View ( Report from the menu.
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This is an example of a very complex query where a Study is created and slowly changing dimensions are demonstrated by identifying the change between two periods of time.  Synchrony is the only analytic software today that combines the power of Studies and temporal technology to track slowly changing dimensions.

Complex query with a Study

Ellie is in the Finance Department of a major credit card company.  She is looking for ways to increase revenue for her company.  She wants to look at the revenue of the customer segment that is expected to have the highest revenue growth rate in her company.  The customer segment criteria has household income over $50,000, no overdrawn status, average debt of $500 or more in 1994, and a family household type.  She will calculate interest revenue by multiplying average current debt by 12% which is the interest rate that her company charges.  She wants to list the report by household income, account number, average current debt, and annual revenue (average current debt multiplied by 12%).

This is a complex query where a Study is created to save the results of a constraint of the customer segment.  Synchrony has the unique ability to create Studies. The results of applying constraints on various dimensions in a report can be saved as a Study.
A calculation is done from the results of the Study to determine interest revenue from average current debt.

Few query tools are able to save the results of constraints as in Synchrony.  Some query tools can create a filter which is a set of constraints, but cannot save the result set from the constraints.  Thus, Synchrony saves the results of constraints which can then be used as the basis of other reports.

To create a new report

· Go to File(New on the menu.

· Click on Credit Transactions.

· Click OK.

· If a dialogue box comes up asking if you want to save the report click No.

· Choose View(Single on the menu.
1. To create a Study:
· This Study has been created for you.  If you wish to create it yourself, follow these steps.  Otherwise, skip to step 2.

a. From the Household dimension, click the Browse [image: image20.png]


 button.

b. In the Browser window, drag and drop Household Income.

c. Click inside the Household Income edit box and type >50000.

d. Drag and drop Household Type and click Family.

e. Click Run.

f. Click Save to save this constraint as a Group.

g. Name the Group Income > $50k and Type = Family.

h. Click OK.

i. Close the Browser window.

j. From the Account dimension, drag and drop Account Key.

k. From Card Transactions (Fact table), drag and drop Current Debt.

l. From the Day dimension, click Groups tab and drag and drop Year = 1994 to the report title.

m. From the Household dimension, click Groups tab and drag and drop Income > $50k and Type = Family to the report title.

n. From the Status dimension, click Groups tab and drag and drop Status = Not Overdrawn to the report title.

o. Right click on column B (Current Debt) and select Properties(Exceptions.

p. For Top Condition, select At or Above Value of M.

q. Enter 500 in the M = edit box.

r. For Report Display, check Restrict to Exceptions.

s. Click OK.

s. Click Run Report.

t. Right click on column A (Account Key) and select Create Study.

u. Name the study Families > $50k income, >$500 debt in 1994, not overdrawn.

v. Click OK.

w. To clear the report used in creating the Study, choose File(New from the menu and select the Credit Transactions family and click OK. When asked if you want to save the report, respond No.

2. To create report title:

· Right click on the report title area.

· Click in the Report Title edit box and type Credit Card Transactions –Query with Study.

· Click Close.

3. To select fields for your report:

· From the Household dimension, drag and drop Household Income to column A.

· From the Account dimension, drag and drop Account No to column B.

· From Card Transactions (Fact Table), drag and drop Current Debt to column C.

4. To select a Study for report:

· From the Account dimension, click the Studies tab and drag and drop the study Families > $50k income, >$500 debt in 1994, not overdrawn onto the report title.

5. To create an average:

· Right click on column C (Current Debt) and select Properties(Aggregate.

· Select Average.

· Click OK.

6. To create a user defined formula for interest revenue:

· From Card Transactions, drag and drop User Defined Formula to column D.

· Click in the edit box for the Calculation and enter C*0.12 - This means column C times 12%.

· Click OK.

7. To create column heading:

· Right click on column D and select Properties(Headings.

· Select all the text in the column Heading edit box and press the Delete key.

· Enter a new heading of Annual Revenue <Enter> at 12% Rate, pressing the Enter key where you see <Enter>.

· Click OK.

8. To run report:

· Click Run Report  [image: image21.png]



9. To view full report:

· Choose View(Report from the menu.
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This is an example of a complex query where a Study is created and a calculation is done on the results of the Study.  Few query tools are able to save the results of constraints as in Synchrony.  Synchrony saves the results of constraints which can then be used as the basis of other reports.

Complex query with a Study and an exception

Ellie is in the Finance Department of a major credit card company.  She wants to look for new ways to increase revenue for her company.  Based on the customer segment created in the previous query (household income over $50,000, no overdrawn status, average debt of $500 or more in 1994, and a family household type),  Ellie wants to identify the subset of customers that carry an average current debt greater than $1000.  She wants to list the household income, account number, account status, average current debt, and total number of transactions in 1994.

This is a complex query that uses a Study created in the previous example that saved the results of constraints on the customer segment. The results of applying constraints on various dimensions in a report can be saved as a Study. Since the Study was saved it is reusable and can be the basis of another query.  This query takes the results of the previous constraint and applies an exception. The exception restricts the constraint to those customers that have average current debt greater than $1000.

To create a new report

· Go to File(New on the menu.

· Click on Credit Transactions.

· Click OK.  

· If a dialogue box comes up asking if you want to save the report click No.
· Choose View(Single on the menu. 
· This report uses the same Study as the previous report.  See that report to see how the Study was created.

1. To select fields for your report:

· From the Household dimension, drag and drop Household Income onto column A.

· From the Account dimension, drag and drop Account No onto column B.

· From the Status dimension, drag and drop Status Description onto column C.

· From Card Transactions (Fact Table), drag and drop Current Debt onto column D.

2. To create report title:

· Right click on the report title area.

· Click in the Report Title edit box and type Credit Card Transactions – Complex Query with Study.

· Click Close.

3. To use a Study created in previous report:

· From the Account dimension, click Studies tab and drag and drop the study Families > $50k income, >$500 debt in 1994, not overdrawn to the report title

4. To create an average:

· Right click on column D (Current Debt) and select Properties(Aggregate.

· Select Average.

· Click OK.

5. To select fields for your report:

· From Card Transactions, drag and drop Number of Transactions onto column E.

6. To select a date to constrain a field:

· From the Day dimension, click Groups tab and drag and drop Year = 1994 to column E (Number of Transactions).

7. To create an exception:

· Right click on top of column D (Current Debt) and select Properties(Exceptions.

· For Top Condition click on At or Above Value of M.

· Enter 1000 in the M = edit box.

· For Report Display, select Restrict to Exceptions.

· Click OK.

8. To run report:

· Click Run Report  [image: image23.png]



9. To select report view:  

· Choose View(Report from the menu.
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This is a complex query where a Study was created in the previous example and used as the basis of this complex query.  An exception is applied to the Study that restricts the constraint to those customers that have average current debt greater than $1000.  Few query tools are able to save the results of constraints as in Synchrony.  Synchrony saves the results of constraints which can then be used as the basis of other reports.

Chapter

3

Grocery Data Mart

Simple query

Caleb is in the Accounting Department of a major grocery store chain.  He wants to compare the total dollar sales for each product for the month of November 1995 compared with November 1994 and see the percentage change between the two.

This is a simple query that compares two snapshots of data in time.  Most query tools can run simple queries such as this one.

To create a new report:

· Go to File(New on the menu.

· Click on Grocery.

· Click OK.

· If a dialogue box comes up asking if you want to save the report click No.

· Choose View(Single on the menu. 


1. To select fields for your report:

· From the Product dimension, drag and drop Description onto column A.

· From Sales (Fact Table), drag and drop Dollar Sales three times onto columns B, C and D.
2. To create report title:

· Right click on the report title area.

· Click in the Report Title edit box and type Simple Query.

· Click Close.

3. To select dates to constrain fields:

· From the Time dimension, click the Groups tab and drag and drop the following:

a. Month = 11/30/1994 to column B.

b. Month = 11/30/1995 to column C.

c. Month = 11/30/1994 to column D.

4. To create a comparison:

· Right click on column D (Dollar Sales 11/1994) and select Properties(Comparison .

· Select Percent Difference of .

· Click OK .

· While holding down the Shift key, drag and drop Month = 11/30/1995 from the Groups tab on the Time dimension onto column D.  Using the shift key sets the date as the one being compared

5. To run report:

· Click Run Report  [image: image25.png]



6. To view full report:

· Choose View(Report from the menu.
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This is a simple query that compares two snapshots of data in time.  Most query tools can run simple queries such as this one.

Complex query

Evan is in the Sales Department of a major grocery store chain.  He wants to increase the number of promotions and amount of sales on products sold in his company.  The manufacturer of the National Bottle brand wants to do a store promotion where samples of the National Bottle drinks are given out along with coupons.  In return, the manufacturer will pay the grocery store chain 1% of the price of each bottle sold.  Evan wants to estimate the incremental sales to his company.  He will make his estimates based on the sales from the last National Bottle brand promotion and add 1% to calculate incremental sales.  He wants to list the description of the product, total sales during the promotion, and incremental sales from the promotion.

This is a complex query where a constraint is created to look at only National Bottle brand products during the period of the last promotion.  Then a user calculation is made to multiply the total sales of the National Bottle brand constraint by 101% to get to incremental sales.  Some query tools can run this type of query.

To create a new report:

· Go to File(New on the menu.

· Click on Grocery.

· Click OK.

· If a dialogue box comes up asking if you want to save the report, click No.

· Choose View(Single on the menu. 
1. To select fields for your report:

· From the Product dimension, drag and drop Full Description onto column A.

· From the Sales (Fact Table), drag and drop Dollar Sales onto column B.

2. To constrain report and create report title:

· From the Product dimension, click the Groups tab and drag and drop Brand = National Bottle onto the report title area.

· From the Promotion dimension, click the Groups tab and drag and drop Promotion Name = Big Promo to the report title area.

· Right click on the report title area.

· Click in the Report Title edit box and type Constraint and User Calculation.

· Click Close.

3. To create a user defined formula:

· From Sales, drag and drop User Defined Formula onto column C.

· Click in the edit box for the Calculation and enter B*1.01 - This means column B times 101%.

· Click OK.

4. To create a column heading:

· Right click on column C and select Properties(Heading.

· Select all the text in the column Heading edit box and press the Delete key.

· Enter a new heading of Incremental Sales.

· Click OK .

5. To run your report:

· Click Run Report  [image: image27.png]



6. To view full report:

· Choose View(Report from the menu.
[image: image28.png]Synchrony - [Single View] [-[o[x]
Ele Edi View Repot Iodks Help

Olz(a| ¢ BlE|o| v=|o] 2] 2]

— T ———__ e
Custome Comt Tine Fieds | Groups | Stues|

& Dol Cost Prodict |

| Dol Sales st [ Dy Number In Horih

& Product Key [ Dy Number Dveral

= Pramaton Key [ Day OFweek

8 Foca et

Constaint and User Caloulaion

Tor Brand = Notional Bolle, Promotion Name = Big Fromo.

[T A B C D E 3 G 1]
7 Sum of
Full Desciiption _ |Dollar Sales _ Incremental Sales |
2| Clear Refrosher 135 02 $354.13 $357.73
3| Clear Refresher 6 0z 426855 $271.25
4| ClearRefiesher 9 02 4361 35011
5| Stiong Cola 1202 $16857 $170.25
6| Stiong Cola 18 02 $531.68 $537.00
7
]
9
10
11
12
13
Kl |

T ety (= [ bam | 4mPM





This is a complex query where a constraint is created and a user calculation is made to the constraint. Some query tools can run this type of query.

Complex Query with a Study and slowly changing dimensions

Ryan is in the Marketing Department of a major grocery store chain.  Some grocery stores were expanded in January 1995 increasing the square footage of the retail space.  He wants to determine if the increase in square footage has caused an increase in the sales of the Western Vegetable brand.  He wants to identify the stores that had an increase in square footage in January 1995 and compare the average sales of the Western Vegetable brand by region and by store between 1994 and 1995 and determine the percentage difference.

This is a very complex query where a Study is created to save the results of a constraint of the grocery stores that had an increase in square footage in January 1994. Synchrony has the unique ability to create Studies. The results of applying constraints on various dimensions in a report can be saved as a Study. 

Slowly changing dimensions contain data that tend to change gradually over time.  Customer and product information are the most common data that varies over time.  If the speed of your industry is outpacing your data, then chances are you have data that varies over time and you need analytic software that can track slowly changing dimensions.  In this example slowly changing dimensions are demonstrated by identifying the change in average sales of the Western Vegetable brand between 1994 and 1995.  Synchrony is the only analytic software today that combines the power of Studies and temporal technology to track slowly changing dimensions.
To create a new report:

· Go to File(New on the menu.

· Click on Grocery.

· Click OK.

· If a dialogue box comes up asking if you want to save the report click No.
· Choose View(Single on the menu. 
1. To select fields for your report:

· From the Store dimension, drag and drop Name to column A.

· From the Store dimension, drag and drop Sales Region  to column B.

· From Sales (Fact Table), drag and drop Dollar Sales four times to columns C, D, E and F.

2. To create report title:

· Right click on the report title area.

· Click in the Report Title edit box and type Slowly Changing Dimension.

· Click Close.

3. To select dates to constrain fields:

· From the Time dimension, click the Groups tab and drag down the following:

a. Year = 1995 to report title

b. Year = 1994 to column C

c. Year = 1994 to column E

d. Year = 1994 to column F

4. To create a Study:

· This Study has been created for you.  If you wish to create it yourself, follow these steps.  Otherwise, skip to step 5.

a. With the Store dimension selected, click the Browse [image: image29.png]


 button.

b. In the Browser window, select Study Changes from the Tools menu.

c. Select the Store Sqft field to study.

d. For Type, choose Value Unchanged.

e. Leave <Any Value> selected in the From box and <All Times> selected for the time constraint for the study.

f. Click OK .

g. Name the study Unchanged Sq. Ft.
h. Click OK.

i. Close the Browser window.

5. To use a Study:

· From the Store dimension, click the Studies tab and drag and drop the study named Unchanged Sq. Ft. to column E.
· When prompted to choose a time period for the study, select All of time and click OK.

6. To create another Study:

· This Study has been created for you.  If you wish to create it yourself, follow these steps.  Otherwise, skip to step 7.

a. With the Store dimension selected, click the Browse [image: image30.png]


 button.

b. In the Browser window, select Study Changes from the Tools menu.

c. Select the Store Sqft field to study.

d. For Type, choose Value Increase.

e. In the box marked Min enter 1.

f. Select Month = 01/31/1995 for the time constraint for the study.

g. Click OK.

h. Name the study Increased Sq. Ft. in 1/95.

i. Click OK.

j. Close the Browser window.

7. To use a Study:

· From the Store dimension, click Studies tab and drag and drop the study named Increased Sq. Ft. in 1/95 to column F.
· When prompted to choose a time period for the study, select All of time and click OK.

8. To create a comparison:

· Right click on column E (Unchanged Sq. Ft.) and select Properties(Comparison.

· Select Percent Difference of.
· Click OK.

· Right click on column F (Increased Sq. Ft.) and select Properties(Comparison.
· Select Percent Difference of.

· Click OK.

· While holding down the Shift key, drag and drop Unchanged Sq. Ft. from the Studies tab on the Store dimension onto column E.  Using the shift key sets the date as the one being compared.

· When prompted to choose a time period for the study, select All of time and click OK.

· While holding down the Shift key, drag and drop Increased Sq. Ft. in 1/95 from the Studies tab on the Store dimension onto column F.  Using the shift key sets the date as the one being compared.

· When prompted to choose a time period for the study, select All of time and click OK.

9. To create an average:

· Right click on column E (Unchanged Sq. Ft.) and select Properties(Aggregate.
· Select Average.
· Click OK.
· Right click on column F (Increased Sq. Ft.) and select Properties(Aggregate.
· Select Average.
· Click OK.
10. To constrain report and create report title:

· From the Product dimension, click the Groups tab and drag and drop Brand = Western Vegetable onto the report title area.

11. To change a column heading:

· Right click on column E and select Properties(Heading.

· Place the cursor in the Column Heading edit box at the end of the line Dollar Sales and press Enter.

· Type for unremodeled stores.

· Click OK.

· Right click on column F and select Properties(Heading.

· Place the cursor in the Column Heading edit box at the end of the line Dollar Sales and press Enter.

· Type for remodeled stores.

· Click OK.

12. To create a sort:

· Right click on column F and select Properties(Sort.

· Select F from Column for primary sort.

· Select Descending from Direction for primary sort.

· Click OK.

13. To run report:

· Click Run Report  [image: image31.png]



14. To switch to report view:

· Choose View(Report from the menu.
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This is an example of a complex query where a Study is created and slowly changing dimensions are demonstrated by identifying the change between two periods.  Synchrony is the only analytic software today that combines the power of Studies and temporal technology to track slowly changing dimensions.

Complex query with a Study and a comparison

Grace is in the Brand Management Department of a major grocery store chain.  She wants to increase the sales of the Big Can brand and Cold Gourmet brand foods.  She wants to determine if promotions of the Big Can brand increases the sales of the Cold Gourmet brand foods.  She wants to identify the stores that had promotions of the Big Can brand and carried the Cold Gourmet brand.  She wants to determine total sales of Cold Gourmet in 1994 and total sales of Cold Gourmet in 1995, and the percentage difference between total unit sales of Cold Gourmet in 1994 and total unit sales of Cold Gourmet in 1995.

This is a complex query where a Study is created to save the results of a constraint of grocery stores that carried the Big Can brand and the Cold Gourmet brand. The results of applying constraints on various dimensions in a report can be saved as a Study. Few query tools are able to save the results of constraints as in Synchrony. A comparison is done on the Study to compare the sales of Cold Gourmet in 1994 and 1995.

To create a new report:

· Go to File(New on the menu.

· Click on Grocery.

· Click OK.

· If a dialogue box comes up asking if you want to save the report, click No.

· Choose View(Single on the menu. 
1. To create Studies:

· These Studies were created for you.  If you wish to create them yourself, follow these steps.  Otherwise, skip to step 2.

a. From the Store dimension, drag and drop Store Key.

b. From Sales (Fact table), drag and drop Dollar Sales.

c. From the Product dimension, click the Groups tab and drag and drop Brand = Big Can onto the report title area.

d. From the Promotion dimension, click the Groups tab then drag and drop All Promos onto the report title area.

e. Right click on column B (Dollar Sales) and select Properties(Exceptions.

f. For Report Display, select Omit Nulls by checking the box.

g. Click OK.

h. Click Run Report.

i. Right click on column A (Store Key) and select Create Study.

j. Name the study Stores with Big Can Promo.

k. Click OK.

l. From Product dimension, select the Groups tab and drag and drop Brand = Cold Gourmet to the report title.

m. Right click on the report title. A dialog box will appear.

n. In the dialog box, select the Promotion dimension then click the Reset button – the Promotions constraint is removed from the report.

o. Click Close.

p. Click Run Report.

q. Right click on column A (Store Key) and select Create Study.

r. Name the study Stores Carrying Cold Gourmet.

s. Click OK.

t. To clear the report used in creating the Study, choose File(New from the menu and select the Grocery family and click OK. When asked if you want to save the report, respond No.

2. To create a Study by combining two Studies:

a. With the Store dimension selected, click the Browse [image: image33.png]


 button.

b. Select Combine from the Tools menu of the Browser.

c. Select the Studies option button.

d. For Constraint A choose Stores with Big Can Promo.

e. For the Operator choose Intersection/AND.

f. For Constraint B choose Stores Carrying Cold Gourmet.

g. Click Save.

h. Name the combined study Stores with Big Can Promo Carrying Cold Gourmet.

i. Click OK.

j. Close the Browser window.

3. To create report title:

· Right click on the report title area.

· Click in the Report Title edit box and type Grocery – Study and Comparison.

· Click Close.

4. To select fields for your report:

· From the Store dimension, drag and drop Name to column A.

· From Sales (Fact Table), drag and drop Dollar Sales to column B.

· From Sales, drag and drop Unit Sales to column C.

5. To use a Study:

· From the Store dimension, click the Studies tab and drag and drop the study Stores with Big Can Promo Carrying Cold Gourmet to the report title.

6. To select dates to constrain fields:

· From the Time dimension, click the Groups tab and drag and drop the following:

a. Year = 1994 to column B

b. Year = 1994 to column C

7. To select brands to constrain fields

· From the Product dimension, click the Groups tab and drag and drop the following:
a. Brand = Cold Gourmet to column B

b. Brand = Cold Gourmet to column C

8. To create a comparison:

· Right click on column B (Dollar Sales) and select Properties(Comparison.

· Select Percent Difference of.

· Click OK.

· Right click on column C (Unit Sales) and select Properties(Comparison 

· Select Percent Difference of.

· Click OK.

· While holding down the Shift key, drag and drop Year = 1995 from the Groups tab on the Time dimension onto column B.  Using the shift key sets the date as the one being compared.

· While holding down the Shift key, drag and drop Year = 1995 from the Groups tab on the Time dimension onto column C.  Using the shift key sets the date as the one being compared.

· While holding down the Shift key, drag and drop Brand = Cold Gourmet from the Groups tab on the Product dimension onto column B.  Using the shift key sets the brand as the one being compared.

· While holding down the Shift key, drag and drop Brand = Cold Gourmet from the Groups tab on the Product dimension onto column C.  Using the shift key sets the brand as the one being compared.

9. To create a sort:

· Right click on column B and select Properties(Sort.

· Select B from Column for the primary sort.

· Select Descending from Direction for the primary sort.

· Click OK.

10. To run report:

· Click Run Report  [image: image34.png]



11. To select report view:

· Choose View(Report from the menu.
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This is a complex query with a Study and a comparison made within the Study.  Few query tools are able to save the results of constraints as in Synchrony.  Synchrony saves the results of constraints that can then be used as the basis of other reports.

Complex query with a Study that is reused

Grace is in the Brand Management Department of a major grocery store chain.  She wants to increase the sales of the Big Can brand and Cold Gourmet brand foods.  Based on the previous question where she identified the stores that had promotions of the Big Can Brand and carried the Cold Gourmet brand foods, Grace now wants to compare by store the sales of Cold Gourmet in 1994 to the sales of Cold Gourmet in 1995 and calculate the percentage difference between the two years.  She wants to compare by store the number of unit sales of Cold Gourmet in 1994 to unit sales of Cold Gourmet in 1995 and calculate a percentage difference between the two years.

This is a very complex query where a Study is reused.  The previous Study which has the results of a constraint is used as the basis of this new report.

To create a new report:

· Go to File(New on the menu.

· Click on Grocery.

· Click OK.

· If a dialogue box comes up asking if you want to save the click No.

· Choose View(Single on the menu. 
1. To create a Study:

· This report uses the same Study called Stores with Big Can Promo Carrying Cold Gourmet as created in the previous report.  If you wish to create the Study, see step 1 in the previous report for directions.

2. To create report title:

· Right click on the report title area.

· Click in the Report Title edit box and type Study with comparison.

· Click Close.

3. To select fields for your report:

· From the Store dimension, drag and drop Name onto column A.

· From Sales (Fact Table), drag and drop Dollar Sales onto column B.

· From Sales, drag and drop Unit Sales onto column C.

· From Sales, drag and drop Dollar Sales onto column D.

· From Sales, drag and drop Unit Sales onto column E.

4. To use a Study:

· From the Studies tab on the Store dimension, drag and drop the study Stores with Big Can Promo Carrying Cold Gourmet to the report title.

5. To select dates to constrain fields:

· From the Time dimension, click Groups tab and drag and drop the following:

a. Year = 1994 to column B

b. Year = 1994 to column C

c. Year = 1994 to column D

d. Year = 1994 to column E

6. To select brands to constrain fields

· From the Product dimension, click the Groups tab and drag and drop the following:
c. Brand = Cold Gourmet to column B

d. Brand = Cold Gourmet to column C

e. Brand = Big Can to column D

f. Brand = Big Can to column E

7. To create comparisons:

· Right click on column B (Dollar Sales) and select Properties(Comparison.

· Select Percent Difference of.

· Click OK.

· Right click on column C (Unit Sales) and select Properties(Comparison.

· Select Percent Difference of.

· Click OK.

· Right click on column D (Dollar Sales) and select Properties(Comparison.

· Select Percent Difference of.

· Click OK.

· Right click on column E (Unit Sales) and select Properties(Comparison.

· Select Percent Difference of.

· Click OK.

· While holding down the Shift key, drag and drop Year = 1995 from the Groups tab on the Time dimension onto column B.  Using the shift key sets the date as the one being compared.

· While holding down the Shift key, drag and drop Year = 1995 from the Groups tab on the Time dimension onto column C.  Using the shift key sets the date as the one being compared.

· While holding down the Shift key, drag and drop Year = 1995 from the Groups tab on the Time dimension onto column D.  Using the shift key sets the date as the one being compared.

· While holding down the Shift key, drag and drop Year = 1995 from the Groups tab on the Time dimension onto column E.  Using the shift key sets the date as the one being compared.

· While holding down the Shift key, drag and drop Brand = Cold Gourmet from the Groups tab on the Product dimension onto column B.  Using the shift key sets the brand as the one being compared.

· While holding down the Shift key, drag and drop Brand = Cold Gourmet from the Groups tab on the Product dimension onto column C.  Using the shift key sets the brand as the one being compared.

· While holding down the Shift key, drag and drop Brand = Big Can from the Groups tab on the Product dimension onto column D.  Using the shift key sets the brand as the one being compared.

· While holding down the Shift key, drag and drop Brand = Big Can from the Groups tab on the Product dimension onto column E.  Using the shift key sets the brand as the one being compared.

8. To create a sort:

· Right click on column B and select Properties(Sort.

· Select B from Column for the primary sort.

· Select Descending from Direction for the primary sort.

· Click OK.

9. To change column headings:

· Right click on column B and select Properties(Heading.

· Place the cursor in the Column Heading edit box at the end of the line Dollar Sales and press Enter.

· Type for Cold Gourmet.

· Click OK.

· Right click on column C and select Properties(Heading.

· Place the cursor in the Column Heading edit box at the end of the line Unit Sales and press Enter.

· Type for Cold Gourmet.

· Click OK.

· Right click on column D and select Properties(Heading.

· Place the cursor in the Column Heading edit box at the end of the line Dollar Sales and press Enter.

· Type for Big Can.

· Click OK.

· Right click on column E and select Properties(Heading.

· Place the cursor in the Column Heading edit box at the end of the line Unit Sales and press Enter.

· Type for Big Can.

· Click OK.

10. To run report:

· Click Run Report  [image: image36.png]



11. To view full report:

· Choose View(Report from the menu.
[image: image37.png]Synchrony - [Single View]

Fie Edt View Repot ook Hep

sl

| % @[ =

(|

[_[CIx]

Sales

<] |- Dimensions [Time: All Times]

Customer Count

Dol Cost
& DolrSaes
= Froduct Koy
= Fromoton ey
= St ey

Product
Promation

e Fios | G | Studes]

o 8 Doy Number n i
8 Doy b Dvera

8% Day Diweek
& Fcalpeiod
& o Floa

Study wih compaisan

Tor Al1Stores n Stores Wi Big Can Promo Caiying Coid Gourmet

Stare No. &

16.43%

B C D E F RS
Percent |
Difference of  Percent Percent Percent
Sum of Difference of  Difference of  Difference of
Dollar Sales Sum of Sum of Sum of
for Cold Gournet  Unit Sales Dollar Sales  Unit Sales
For Cold Gourmet  for Big Can for Big Can
for Year = 1995 for Yea
Name Sorted Down vs. Year = 1994 vs. Year = 1994
Store No. 15 49727 a68x 1872%
Store No. 13 00 591% 11837
Stare No. 2 XA 15097 320%
Store No. 1 201% 593% 11.92%
Store No. 10 227 432% a48%
Store No. 17 1851% 753% 1487%
Store No. 12 15.70% 1366% 1527%
13197 400%

ety B

| amm

[ iztiPm





This is a very complex query where a Study is reused.  The previous report created a Study which saved the results of constraints and is used as the basis of this new report.

Chapter

4

Frequent Flyer Data Mart

Simple query

Andy is in the Pricing Department of a large airline.  He wants to understand the growth in fares by fare class for the month of November 1995 compared to November 1994.

This is a simple query that compares two snapshots of data in time.  Most query tools can run simple queries such as this one.

To create a new report

· Go to File(New on the menu.

· Click on Frequent Flyer.

· Click OK.

· If a dialogue box comes up asking if you want to save the report, click No.

· Choose View(Single on the menu. 
1.  To select fields for your report:

· From the Fare Class dimension, drag and drop Fare Class Description onto column A.

· From Frequent Flyer (Fact Table), drag and drop Fare three times onto columns B, C and D.

· From the Date Flown dimension, click Groups tab and drag and drop the following:

a. Flown Month = 11/1994 to column B

b. Flown Month = 11/1995 to column C

c. Flown Month = 11/1994 to column D

2. To create report title:

· Right click on the report title area.

· Click in the Report Title edit box and type Frequent Flyer – Nov 94 vs. Nov 95.

· Click Close.
3. To create a comparison:

· Right click on column D (Fare 11/1994) and select Properties(Comparison.

· Select Difference of.

· Click OK.

· While holding down the Shift key, drag and drop Flown Month = 11/1995 from the Groups tab on the Date Flown dimension onto column D.  Using the shift key sets the date as the one being compared.

4. To run report:

· Click Run Report  [image: image38.png]



5. To select report view:

· Choose View(Report from the menu.
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This is a simple query that compares two snapshots of data in time.  Most query tools can run simple queries such as this one.

Complex query

Jason is in the Finance Department of a large airline.  He is looking for ways to decrease the cost of his sales channels.  He has just been told that his airline is considering reducing the commission paid to the travel agent sales channel.  He wants to determine the average ticket fares in each ticket fare class in 1995 and compare the average ticket fares in the travel agent sales channel to the direct counter sales channel.

This is an example of a complex query where a constraint is created to identify ticket fares in the travel agent sales channel and in the direct counter sales channel.  A comparison is made between the two constraints.  Some query tools are able to run this complex query.

To create a new report:

· Go to File(New on the menu.

· Click on Frequent Flyer.

· Click OK.

· If a dialogue box comes up asking if you want to save the report, click No.

· Choose View(Single on the menu. 
1. To select fields for your report:

· From the Fare Class dimension, drag and drop Fare Class Description onto column A.

· From Frequent Flyer (Fact Table), drag and drop Fare three times onto columns B, C and D.

· From the Groups tab  on the Sales Channel dimension, drag and drop the following:

a. Channel Name = Travel Agent to column B

b. Channel Name = Direct Counter to column C

c. Channel Name = Direct Counter to column D

2. To create report title:

· Right click on the report title area.

· Click in the Report Title edit box and type Frequent Flyer – Agent vs. Counter Sales.

· Click Close.
3. To create a comparison:

· Right click on column D (Fare Direct Counter ) and select Properties(Comparison.

· Select Percent Difference of.

· Click OK.

· While holding down the Shift key, drag and drop Channel Name = Travel Agent from the Groups tab on the Sales Channel dimension onto column D.  Using the shift key sets the channel as the one being compared.

· From the Groups tab on the Date Flown dimension, drag and drop Flown Year = 1995 onto the report title.

4. To run report:

· Click Run Report  [image: image40.png]



5. To View Report:

· Choose View(Report from the menu.
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This is an example of a complex query where a constraint is created and a comparison is made.  Some query tools are able to run this complex query.

Complex query and slowly changing dimensions 

Claudia is in the Marketing Department of a large airline.  She is looking to increase revenue by offering new products to a profitable segment of customers.  In identifying a profitable segment of customers, she wants to understand how increases in household income affect increases in miles flown on her airline.  She wants to identify customers that had an increase in household income of between 1% and 15%  and those with an increase greater than 15%.  She then wants to compare the number of miles each group flew in 1994 compared to the number of miles each group flew in 1995 and find the percentage difference in miles flown between the two years for each group.  She wants to sort the results in descending order by the difference in miles between 1994 and 1995 for all customers.

This is a very complex query where two Studies are created; one that saves the results of constraints for the customers with a 1-15% increase in household income, and a second Study that saves the results of constraints for the customers with a greater than 15% increase in household income. The results of applying constraints on various dimensions in a report can be saved as a Study. Few query tools are able to save the results of constraints as in Synchrony.
Slowly changing dimensions contain data that tend to change gradually over time.  Customer and product information are the most common data that varies over time.  If the speed of your industry is outpacing your data, then chances are you have data that varies over time and you need analytic software that can track slowly changing dimensions.  In this example, slowly changing dimensions are demonstrated by identifying the change in miles flown between 1994 and 1995 for each group of customers that had an increase in household income.  Synchrony is the only analytic software today that combines the power of Studies and temporal technology to track slowly changing dimensions.
To create a new report

· Go to File(New on the menu.

· Click on Frequent Flyer.

· Click OK.

· If a dialogue box comes up asking if you want to save the report click No.
· Choose View(Single on the menu.
1. To select the fields for your report:

· From the Customer dimension, drag and drop Customer Name onto column A.

· From Frequent Flyer (Fact Table), drag and drop Miles five times onto columns B, C, D, E and F.

· From the Groups tab on the Date Flown dimension, drag and drop the following:

a. Flown Year = 1994 to column B

b. Flown Year = 1995 to column C

c. Flown Year = 1994 to column D

d. Flown Year = 1994 to column E

e. Flown Year = 1994 to column F

f. Flown Year = 1995 to report title

2. To create report title:

· Right click on the report title area.

· Click in the Report Title edit box and type Frequent Flyer with SCD.

· Click Close.
3. To create a Study:

· This Study has been created for you.  If you wish to create it yourself, follow these steps.  Otherwise, skip to step 4.

a. With the Customer dimension selected, click the Browse [image: image42.png]


 button.

b. In the Browser window, select Study Changes from the Tools menu.

c. Select the Customer Income field to study.

d. For Type, choose Percent Increase.

e. In the box labeled Min, enter 0.01.

f. In the box labeled Max, enter 0.15.

g. Leave <All Times> selected for the time constraint for the study.

h. Click OK.

i. Name the study Income Increase 1-15%.

j. Click OK.

k. Close the Browser window.

4. To use a Study:

· From the Customer dimension, click the Studies tab and drag and drop the study named Income Increase 1-15% to column E.

· When prompted to choose a time period for the Study, select All of time and click OK.

5. To create a Study:

· This Study has been created for you.  If you wish to create it yourself, follow these steps.  Otherwise, skip to step 6.

a. With the Customer dimension selected, click the Browse [image: image43.png]


 button.

b. In the Browser window, select Study Changes from the Tools menu.

c. Select the Customer Income field to study.

d. For Type, choose Percent Increase.

e. In the box marked Min enter 0.15.

f. Leave <All Times> selected for the time constraint for the study.

g. Click OK.

h. Name the study Income Increase > 15%.

i. Click OK.

j. Close the Browser window.

6. To use a Study:

· From the Customer dimension, click Studies tab and drag and drop the study named Income Increase > 15% to column F.

· When prompted to choose a time period for the Study, select All of time and click OK.

7. To create a comparison:

· Right click on column D (Miles 1994) and select Properties(Comparison.

· Select Percent Difference of.

· Click OK.

· Right click on column E (Income Increase 1-15% 1994) and select Properties(Comparison.

· Select Percent Difference of.

· Click OK.

· Right click on column F (Income Increase > 15% 1994) and select Properties(Comparison.

· Select Percent Difference of.

· Click OK.

· While holding down the Shift key, drag and drop Income Increase 1-15% from the Studies tab on the Customer dimension onto column E (Percent Difference with Income Increase 1-15%).  Using the shift key sets the date as the one being compared.

· When prompted to choose a time period for the Study, select All of time and click OK.

· While holding down the Shift key, drag and drop Income Increase > 15% from the Studies tab on the Customer dimension onto column F (Percent Difference with Income Increase > 15%).  Using the shift key sets the date as the one being compared.

· When prompted to choose a time period for the Study, select All of time and click OK.

8. To create a sort:

· Right click on column D (Percent Difference) and select Properties(Sort.

· Select D from the Column drop down list box for the primary sort.

· Select Descending from the Direction drop down list box for the primary sort.

· Click OK.

9. To change column headings:

· Right click on column B and select Properties(Heading.

· Select all the text in the Column Heading edit box and press the Delete key.

· Enter a new heading of Miles Flown <Enter> in 1994, pressing the Enter key where you see <Enter>.

· Click OK.

· Right click on column C and select Properties(Heading.

· Select all the text in the Column Heading edit box and press the Delete key.

· Enter a new heading of Miles Flown <Enter> in 1995, pressing the Enter key where you see <Enter>.

· Click OK.

· Right click on column D and select Properties(Heading.

· Select all the text in the Column Heading edit box and press the Delete key.

· Enter a new heading of Change in Miles Flown <Enter> for All Customers <Enter> From 1994 to 1995 <Enter> Sorted Down, pressing the Enter key where you see <Enter>.

· Click OK.

· Right click on column E and select Properties(Heading.

· Select all the text in the Column Heading edit box and press the Delete key.

· Enter a new heading of Change in Miles Flown <Enter> for Customers with <Enter> Income Increase of 1-15% <Enter> From 1994 to 1995, pressing the Enter key where you see <Enter>.

· Click OK.

· Right click on column F and select Properties(Heading.

· Select all the text in the Column Heading edit box and press the Delete key.

· Enter a new heading of Change in Miles Flown <Enter> for Customers with <Enter> Income Increase of > 15% <Enter> From 1994 to 1995, pressing the Enter key where you see <Enter>.

· Click OK. 

10. To remove blank rows:

· Right click on column D and select Properties(Exceptions.
· Check the Omit Nulls box.
· Click OK.
11. To run report:

· Click Run Report  [image: image44.png]



12. To view full report:

· Choose View(Report from the menu.
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This is an example of a very complex query where two Studies are created and slowly changing dimensions are tracked for each Study.  Obtaining the answer to this very complex question is extremely difficult. Only Synchrony with its ability to create Studies and apply temporal technology can perform this query easily.

Complex query with a Study

Matthew is in the Marketing Department of a large airline.  He wants to send direct mail advertising to a targeted group of customers that fly out of JFK Airport in New York.  He wants to identify the customers that flew from JFK Airport in November 1994 and had over 500 miles in their account. He wants to produce the mailing list that includes customer name, address, city, state, zip code, and number of miles flown.

This is a complex query where a Study is created that saves the results of constraints that represents the set of customers that flew out of JFK Airport in November 1994 and had over 500 miles in their account. The results of applying constraints on various dimensions in a report can be saved as a Study. Few query tools are able to save the results of constraints as in Synchrony. This complex query also demonstrates that atomic data (transaction level data) can be obtained and individual customer account information can be put onto a report for a Marketing direct mailing.

To create a new report:

· Go to File(New on the menu.

· Click on Frequent Flyer.

· Click OK.

· If a dialogue box comes up asking if you want to save the report click No.

· Choose View(Single on the menu. 
1. To create a Study:

· This Study was created for you.  If you wish to create it yourself, follow these steps.  Otherwise, skip to step 2.

a. From the Customer dimension, drag and drop Customer Key.

b. From the Groups tab on the Date Flown dimension, drag and drop Flown Month = 11/1994 onto the report title.

c. From the Groups tab on the Trip Origin dimension, drag and drop Trip Origin Name = JFK onto the report title area.

d. Click Run Report.

e. Right click on column A (Customer Key) and select Create Study.

f. Name the study Flew in 11/94 from JFK.

g. Click OK.

h. Open a new report in the Frequent Flyer family.

i. Click No when asked if you want to save the report.

2. To create report title:

· Right click on the report title area.

· Click in the Report Title edit box and type Frequent Flyer Study.

· Click Close.
3. To select fields for your report:

· From the Customer dimension, drag and drop Customer Name onto column A.

· From the Customer dimension, drag and drop Customer Address onto column B.

· From the Customer dimension, drag and drop Customer City onto column C.

· From the Customer dimension, drag and drop Customer State onto column D.

· From the Customer dimension, drag and drop Customer Zip onto column E.

· From Frequent Flyer (Fact Table), drag and drop Miles onto column F.

4. To create an exception:

· Right click on column F (Miles) and select Properties(Exceptions.

· For Top Condition, click  At or Above Value of M.

· Enter 500 in the M = edit box.

· For Report Display, select Restrict to Exceptions.

· Click OK.

5. To use a Study:

· From the Studies tab on the Customer dimension, drag and drop the study Flew in 11/94 from JFK onto the report title area.

6. To run report:

· Click Run Report  [image: image46.png]



7. To view full report:

· Choose View(Report from the menu.

[image: image1.png]



This is a complex query where a Study is created and atomic data reported in the form of customer names and address.  Few query tools are able to create Studies that saves the results of constraints and report atomic data.

Complex query with a Study on a Study

Matthew is in the Marketing Department of a large airline.  He wants to send direct mail advertising to a target group of customers.  In the previous query, he identified the customers that flew from JFK Airport in November 1994 and had over 500 miles in their account. Now he thinks that he wants to refine his target group and identify from the original group the subset of customers that had household income over $50,000 and are married.  He wants to list the customer name, address, city, state, zip code, marital status, income, number of miles flown in 1994 so that he can do a direct mailing from this report.

This is a very complex query where a Study on a Study is created.  The previous Study which saved the results of a constraint for a target group of customers is used as the basis of this new Study.  The new Study is a subset of the results of the previous constraint.  Synchrony stands alone in its ability to create Studies on Studies.

To create a new report

· Go to File(New on the menu.

· Click on Frequent Flyer.

· Click OK.

· If a dialogue box comes up asking if you want to save the report click No.
· Choose View(Single on the menu.

1. To create a Study:

· This Study has been created for you.  If you wish to create it yourself, follow these steps.  Otherwise, skip to step 2.

a. From the Customer dimension, drag and drop Customer Key.
b. From the Groups tab on the Customer dimension, drag and drop Married and Income > $50k onto the report title area.
c. From the Studies tab on the Customer dimension, drag and drop Flew in 11/94 from JFK onto the report title area.
d. Click Run Report.
e. Right click on column A (Customer Key) and select Create Study.
f. Name the study Flew 11/94 from JFK, Married, High Income.
g. Click OK.
h. Open a new report in the Frequent Flyer family.
i. Click No when asked if you want to save the report. 

2. To create report title:

· Right click on the report title area.

· Click in the Report Title edit box and type Frequent Flyer - Study on Study.

· Click Close.
3. To select fields for your report:

· From the Customer dimension, drag and drop Customer Name.
· From the Customer dimension, drag and drop Customer Address.

· From the Customer dimension, drag and drop Customer City.

· From the Customer dimension, drag and drop Customer State.

· From the Customer dimension, drag and drop Customer Zip.
· From the Customer dimension, drag and drop Customer Marital.
· From the Customer dimension, drag and drop Customer Income.
· From Frequent Flyer (Fact Table), drag and drop Miles.
· From Frequent Flyer, drag and drop Fare.
4. To use a Study:

· From the Studies tab on the Customer dimension, drag and drop the study Flew 11/94 from JFK, Married, High Income onto the report title.
5. To constrain report:

· From the Groups tab on the Date Flown dimension, drag and drop Flown Year = 1994 to the report title.
6. To run report:

· Click Run Report  [image: image47.png]



7. To select report view:

· Choose View(Report from the menu.
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This is a very complex query where a Study on a Study is created.  Few query tools are able to save the results of constraints as in Synchrony and no other is able to subset and then save the results of the previous constraints.  The new subset is saved and can be used as the basis of a new query.  Synchrony stands alone in its ability to create Studies on Studies.







�PAGE \# "'Page: '#'�'"  ��I’m not sure why it wouldn’t be easier to explani to them about single view and star view.  If the goal  is to get people to understand the software, the star view is more condusive to learning, it is a superior visual representation.  At least some of our examples will support star view…..
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